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Chapter   1

Introduction

This chapter describes the Sun Java™ Web Infrastructure Suite (Java WIS) and the 
EZOffering for Java WIS. This chapter is organized in the following sections:

• “The Sun Java Web Infrastructure Suite” on page 11

• “The EZOffering for Java WIS” on page 12

• “EZOffering #0: Fastplay Enterprise Web Services” on page 15

• “EZOffering #1: Origin and Content Server” on page 17

• “EZOffering #2: Server-side Java Applications” on page 17

• “EZOffering #3: Web Proxy Services” on page 18

• “EZOffering #4: Secure Web Infrastructure” on page 20

The Sun Java Web Infrastructure Suite
Java WIS is comprised of web and identity infrastructure components from Sun 
Java Enterprise System. The Java WIS core components are:

• Sun Java Application Server 8.1, Standard Edition (Application Server)

• Sun Java Directory Server 5.2 P4 Enterprise Edition (Directory Server)

• Sun Java System Access Manager 7.0 (Access Manager)

• Sun Java System Web Server 6.1 SP5 (Web Server)

• Sun Java System Web Proxy Server 4.0 (Web Proxy Server)
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Using Java WIS components, you can build an infrastructure for web services, web 
applications, and server-side Java applications. Depending on your requirements, 
you can build anything from a basic infrastructure for HTML and CGI content to a 
secure, access-controlled infrastructure for server-side Java applications.

Java WIS provides an affordable, quick-start approach to Web services, and it 
provides the simplicity, ease-of-use, and out-of-the-box integration of a fully 
featured platform. The Java WIS components can be deployed in a number of 
architectures that help organizations reduce the cost of providing web applications 
and web services, improve web security, and strengthen their online relationships 
with their customers.

The EZOffering for Java WIS
The EZOffering for Java WIS is a fast, reliable, and consistent way for you to 
deploy Java WIS. The EZOffering includes five pre-architected offerings. To use the 
EZOffering, you select one of the offerings, and EZOffering performs the entire 
deployment, even when the deployment is distributed across several computers.

Each EZOffering is based on a different architecture, and each offering showcases a 
different aspect of the Java WIS. The five offerings are summarized in Table 1-1.

Table 1-1 Java WIS EZOfferings

Offering Benefits Includes 
Sample 
Application?

Fastplay Enterprise Web 
Services

Primarily for evaluating Java WIS; this 
offering deploys the core components and a 
sample enterprise web service application, 
including user accounts, and showcases the 
key features of the suite. This is a 
one-computer deployment.

Yes
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Web Server System and Content 
Server

Provides an infrastructure for reliable HTTP 
services. This offering uses Web Server as 
the content server. Web Server can be 
configured to support:

• Static HTML content

• CGI

• Java applications (Java Servlets and 
JavaServer™ Pages (JSP™ Pages). 
The WebDAV and Search features are 
also enabled.

This offering can be deployed on one or 
more computers.

No. You 
provide and 
deploy 
content.

Sun Java System Application 
Server

Provides a Java 2 Platform, Enterprise 
Edition (J2EE™) 1.4 platform infrastructure 
for web content. This offering uses 
Application Server as the content server. 
Application Server supports:

• Static HTML content

• CGI

• Java applications (Java Servlets and 
JSP Pages)

• Server-side Java applications

This offering can be deployed on one or 
more computers.

No. You 
provide and 
deploy 
content.

Web Proxy Services Provides a secure infrastructure for web 
content, using proxy services to secure the 
content server. This offering can use either 
Web Server, Application Server, or an 
existing web service as the content server. 
The type of content supported depends on 
the content server.

If you deploy the proxy service using an 
existing web service as the content server, 
you need only one computer. If you deploy a 
content server as part of this offering, you 
need two computers, one for the content 
server and one for the proxy server.

No. You 
provide and 
deploy 
content.

Table 1-1 Java WIS EZOfferings (Continued)

Offering Benefits Includes 
Sample 
Application?
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The EZOffering provides the following two modes for installing and deploying the 
offerings:

• the Fastplay deployment mode

• the Advanced deployment mode

These deployment modes are described in the following sections.

The Fastplay Deployment Mode
The Fastplay deployment mode is intended for your evaluation of Java WIS. The 
Fastplay deployment mode deploys Java WIS core components and a sample 
application with the minimum of user interaction. Immediately after the Fastplay 
deployment is complete, you can log in to the sample application and evaluate Java 
WIS features, including access control. The main characteristics of the Fastplay 
deployment mode are the following:

Secure Web Infrastructure Provides a secure infrastructure for web 
content, using proxy services to secure the 
content server and access management 
services to control access to web content. 
This offering uses Application Server as the 
content server. Application Server supports:

• Static HTML content

• CGI

• Java applications (Java Servlets and 
JSP Pages). The WebDAV and Search 
features are also enabled.

• Server-side Java applications

This offering uses Web Proxy Server as the 
proxy server. This offering also uses Access 
Manager and Directory Server for access 
management.

This offering must be deployed on at least 
two computers, one for the web container, 
Access Manager, and Directory Server, and 
the second for the proxy service.

No. You 
provide and 
deploy 
content.

Table 1-1 Java WIS EZOfferings (Continued)

Offering Benefits Includes 
Sample 
Application?
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❍ the Fastplay offering is a single computer deployment

❍ the Fastplay offering can only be deployed on X64/X86 architectures (the 
Fastplay option is not available on SPARC hardware)

❍ the Fastplay offering can only be deployed on computers with attached 
screen and keyboard (the Fastplay option cannot be deployed on remote 
computers)

❍ the Fastplay offering provides only one deployment architecture 
(described in “EZOffering #0: Fastplay Enterprise Web Services” on 
page 15)

The Advanced Deployment Mode
The Advanced deployment mode is more flexible than the Fastplay deployment 
mode. The Advanced deployment mode is for system administrators who want to 
deploy a production web infrastructure and then deploy their own content to that 
infrastructure. The main characteristics of the Advanced mode are:

❍ the Advanced offerings can be deployed on one or more computers

❍ the Advanced offerings can be deployed on both X64/X86 and SPARC 
architectures

❍ the Advanced offerings can be deployed on computers with attached 
screen and keyboard and on remote computers

❍ the Advanced offerings are more flexible in their network settings than the 
Fastplay offering

❍ the Advanced offerings include a variety of deployment architectures 
(described in “EZOffering #1: Origin and Content Server” on page 17, 
“EZOffering #2: Server-side Java Applications” on page 17, “EZOffering 
#3: Web Proxy Services” on page 18, and “EZOffering #4: Secure Web 
Infrastructure” on page 20)

The EZOffering deployment architectures are described in the following sections.

EZOffering #0: Fastplay Enterprise Web Services
The Fastplay offering deploys the architecture illustrated in Figure 1-1. The 
Fastplay offering can only be deployed on a single computer. 
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Figure 1-1 EZOffering #0 Fastplay Architecture

The Fastplay deployment includes Application Server, Access Manager, Directory 
Server, and a sample enterprise web application. The sample application is a 
business portal for an imaginary company named Adventure Sports Café. 
Figure 1-1 shows the sample application running in Application Server’s web 
container. The sample application is an HTTP-only application, but Application 
Server is J2EE 1.4 platform compatible, and this set of components is capable of 
delivering web services and server-side Java applications.

As soon as you complete the Fastplay deployment, you can log in to the sample 
application and see how the components interoperate to provide reliable HTTP 
services and secured access to the sample application. 

When you log in to the sample application, Access Manager prompts you for a user 
name and password. When you supply a user name and password, Access 
Manager uses Directory Server’s repository of identity profiles and access 
privileges to validate your login request.

You can log in to the Access Manager console to add new users and modify the 
privileges of existing users. You can also log in to the Application Server 
Administration Console to see the deployed instances of Access Manager and the 
sample application.

Directory Server

HTTP
Requests

Application Server

Web Container

Access Manager

Sample Application
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EZOffering #1: Origin and Content Server
The Origin and Content Server offering uses Web Server as the content server, and 
it provides basic infrastructure for reliable HTTP services. The architecture is 
illustrated in Figure 1-2.

Figure 1-2 EZOffering #1 Origin and Content Server Architecture

This architecture uses Web Server to deliver content that you supply. As part of the 
EZOffering deployment process, you can configure Web Server for the following 
types of content:

• Basic Configuration for static HTML content.

• Extended Configuration for static HTML content and CGI content. The 
WebDAV (Web-based Distributed Authoring and Learning) feature is also 
configured.

• Advanced Configuration for static HTML content, CGI and Java applications 
(Java Servlets and JSP Pages). The WebDAV and Search features are also 
configured.

The minimum number of computers required for this offering is one. You can scale 
this offering by deploying the offering on additional computers, with each 
computer running one instance of Web Server.

EZOffering #2: Server-side Java Applications
The Server-side Java Applications offering uses Application Server as the content 
server, and it provides a high-performance, J2EE 1.4 platform compatible 
infrastructure for web content and server-side Java applications. The architecture is 
illustrated in Figure 1-3.
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Figure 1-3 EZOffering #2 Server-side Java Applications Architecture

This architecture uses Application Server to deliver content that you supply. 
Application Server supports, among others, the following types of content:

• Static HTML content.

• CGI content. The WebDAV (Web-based Distributed Authoring and Learning) 
feature is also configured.

• Java Servlets and JSP pages.

• Enterprise JavaBeans™ (EJB™ component architecture).

The minimum number of computers required for this offering is one. You can scale 
this offering by deploying the offering on additional computers, with each 
computer running one instance of Application Server.

EZOffering #3: Web Proxy Services
The Web Proxy Services offering combines a content server and a secure proxy 
server to create a secure infrastructure for web content. The architecture for this 
offering has three related variations, which are illustrated in Figure 1-4. When you 
deploy the Web Proxy Services offering, you select one of these variations.
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Figure 1-4 EZOffering #3 Web Proxy Services Architecture

The architecture uses Web Server’s Reverse Proxy Plug-in to provide a layer of 
indirection between the user and the web content server. Users submit their HTTP 
requests to the Reverse Proxy Plug-in, which is running on one computer; the 
Reverse Proxy Plug-in redirects the request to the actual application, which is 
running on another computer. The actual application remains invisible to the user. 
As illustrated in Figure 1-4, EZOffering can deploy three variations of this 
architecture:
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• Web Proxying with Web Server. EZOffering deploys Web Server configured 
with the reverse proxy plug-in on one computer and another instance of Web 
Server configured as the content server on a second computer. You use two 
computers for this variation.

• Web Proxying with Application Server. EZOffering deploys Web Server 
configured with the reverse proxy plug-in on one computer and an instance of 
Application Server as the content server on a second computer. You use two 
computers for this variation.

• Web Proxying with your existing web service. EZOffering deploys Web 
Server configured with the reverse proxy plug-in on one computer. When you 
deploy, you specify an existing web service or web application that is already 
running on a second computer as your content server, and EZOffering 
configures the reverse proxy plug-in to proxy for your existing web service or 
web application. You deploy the EZOffering on one computer, in conjunction 
with an existing web service or web application that is already running on a 
second computer.

Depending on the variation you select, this architecture uses Application Server, 
Web Server, or your existing server product to deliver content that you supply. 
Choose the variation that supports the type of content you want to serve.

EZOffering #4: Secure Web Infrastructure
The Secure Web Infrastructure Offering combines a content server with a web 
proxy server and access management to create a highly secure infrastructure for 
web content. The architecture for this offering is illustrated in Figure 1-5.
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Figure 1-5 EZOffering #4 Secure Web Infrastructure Architecture

The architecture combines the following components and features:

• Application Server provides a reliable HTTP delivery service, supporting a 
wide range of content types.

• Web Proxy Server provides a proxy service that protects your web services 
and applications from direct exposure to users.

• Access Manager controls access to the web-based applications deployed on 
Application Server.

• Directory Server provides a central repository for storing, managing, and 
protecting identity profiles and access privileges, as well as information about 
applications and network resources.

The minimum number of computers required for this offering is two; one for Web 
Proxy Server, and the second for all other components. For better performance, you 
can deploy Directory Server separately on a third computer.
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Chapter   2

The Fastplay Offering

This chapter describes the Fastplay offering, which deploys the core components of 
Java WIS on one computer for you to evaluate the suite. This chapter contains the 
following sections:

• “Deploying the Fastplay Offering” on page 23

• “Evaluating the Fastplay Offering” on page 27

You can deploy the Fastplay offering with a few clicks. The Fastplay deployment is 
only available for x64 and x84 architectures, and only on computers with attached 
monitor and a keyboard. 

If you want to perform the evaluation on SPARC hardware, use the advanced 
installation mode and choose offering #0. For more information, see “The 
Advanced Offerings” on page 35.

Deploying the Fastplay Offering
To deploy the Fastplay offering, you perform the following procedures:

1. Installing the Fastplay offering. This procedure installs the Solaris™ 10 
Operating System (OS) and all the Java WIS component packages.

2. Deploying the Fastplay offering. This procedure configures and then starts 
the Java WIS components used in the offering.

CAUTION The EZOffering installation procedure installs the Solaris 10 OS on 
your selected disk, and all information on the disk (your current OS 
and your data) will be lost.
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EZOffering guides you through the installation and deployment procedures, 
which are described in the following sections.

➤ To Install the Fastplay Offering

1. Insert the EZOffering DVD into the computer on which you want to deploy the 
Fastplay offering.

The DVD contains a Solaris 10 OS installation program.

2. The installation program opens a menu that allows you to choose a 
deployment mode. This menu contains the following options:

EZO WIS (S10U1+JES4) -> FASTPLAY

EZO WIS (S10U1+JES4) -> ADVANCED screen/keyboard/mouse

EZO WIS (S10U1+JES4) -> ADVANCED remote console (ttya)

EZO WIS (S10U1+JES4) -> ADVANCED remote console (ttyb)

3. Choose Fastplay.

The installation program attempts to detect any network settings you may 
have (by using network information obtained from a DHCP server). If the 
installation program detects any network settings, it configures the computer 
with the detected domain name.

4. The installation program opens another menu, which allows you to choose the 
installation mode. Press 2 to choose the default installation mode (Custom 
Jumpstart (default)), or wait for the 30 second timeout.

CAUTION The EZOffering installation procedure installs the Solaris 10 OS on 
the disk you select; all information on the disk (your current OS and 
your data) will be lost.

NOTE If the installation program is unable to detect 
any network settings, it configures the 
computer in standalone mode on your behalf, 
with the following settings:

❍ Hostname: fastplay

❍ Domain name: ezo.com

❍ Root Password: welcome
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5. The installation program tests the video hardware and displays a proposed 
windowing system configuration. Press Enter to accept the recommended 
configuration (or wait for the 30 second timeout).

6. The installation program reminds you that it will erase all information on the 
disk and prompts you to confirm that you willing to erase the disk. Enter Y to 
start the extraction process.

The installation program extracts the DVD data to the disk.

7. When the installation program completes the extraction process, the DVD is 
ejected. Depending upon the hardware you are using, the installation program 
might prompt you to press Return. Remember that the root password of the 
system is welcome.

8. The computer reboots. Wait for the reboot to complete.

9. When the computer reboots it launches Java Desktop System and opens the 
Java Desktop System Welcome screen. You are automatically logged in as 
root. 

10. The EZOffering Fastplay Deployment wizard opens. The Fastplay Deployment 
wizard guides you through the deployment phase.

➤ To Deploy the Fastplay Offering:

1. When the installation procedures is complete the Solaris 10 OS login page is 
displayed. Log in using the following user account:

❍ User: root

❍ Password: welcome

2. The deployment wizard opens the EZOffering Java Web Infrastructure Suite 
Welcome page. Click Next.

3. The deployment wizard displays the computer’s hostname (configured by 
Fastplay installation process). Click Confirm.

NOTE If the computer has more than one disk, the installation program 
prompts you to choose the disk on which the Java WIS Fastplay 
option is installed.

TIP Depending upon your DVD reader’s speed, the extraction process 
may take some time (around 30 minutes). Please be patient.
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4. The deployment wizard opens the licensing agreement. Read the licensing 
agreement. Enter Yes to accept the licensing agreement.

5. The deployment wizard opens the EZOffering Welcome screen. Click Next.

6. The deployment wizard opens the Licensing Agreement page. Click Next to 
accept the licensing agreement.

7. The deployment wizard prompts you for the Java WIS administration 
password. This password is the administration password for all the 
components in the offering you are deploying. The password must be more 
than 8 characters long. Enter the password and click Next.

8. The deployment wizard opens the Ready To Deploy page. Click Next to begin 
the deployment.

The deployment wizard displays a monitoring GUI that allows you to track the 
progress of the deployment.

9. When the deployment wizard completes the deployment process, it highlights 
the Next button. When the Next button is highlighted, click Next.

10. The deployment wizard opens the Finish page. Click Finish to terminate the 
wizard.

EZOffering opens a web browser window that displays the welcome page for 
the Fastplay offering.

You can continue with the evaluation procedures.

CAUTION Record your password. You will need the password to log into your 
deployed components.

TIP Some of the deployment steps might take some time (10 - 30 
minutes); please be patient. 
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Evaluating the Fastplay Offering
This section describes a number of procedures you can follow to evaluate Java WIS 
features. When you follow these procedures you experience the Java WIS 
EZOffering deployment from several points of view: as an end user, as a system 
administrator who manages user accounts, and as a senior system administrator 
who manages the Java WIS infrastructure.

Experiencing the Java WIS Infrastructure as an 
End User
The procedures in this section demonstrate how Access Manager, a component of 
Java WIS, secures access to the sample application by requiring a user name and 
password to access the sample portal application.

The procedures in this section also demonstrate how Java WIS infrastructure can 
provide custom content for different users.

➤ To Log in into the Adventure Sports Cafe Application

In this procedure, you log in to the sample application twice, using two different 
user names. The user accounts were created by the Fastplay deployment. You see 
the interoperation between the content server and Access Manager. You also see 
that the portal content is customized for each user.

1. The URL for the EZ offering #0 Fastplay Welcome page is the following:

http://<machine name>/ezo/welcome.html

If the Welcome page is not already open in your web browser, open it now.

2. In the Welcome page, click Access the Adventure Sports Cafe.

The Adventure Sports Cafe home page opens.

3. Using the fields in the upper right corner of the page, log into the Adventure 
Sports Cafe. Type the following values:

User Name: mary

Password: ascsample

Click Log In. The Home tab displays content that is available to all users.

4. Explore the content on the Home tab; click any links that interest you.
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5. Click the MyPortal tab.

This tab displays content that is customized for the user. Notice that Mary 
Manager’s Project List has three items: Public Outreach, Australia Expansion, 
and New Customer Tours.

6. Click Logout.

7. Log into the Adventure Sports Cafe a second time. Type the following values:

    username: chris

    password: ascsample

Click Log In. 

8. Click the MyPortal tab. 

Notice that Chris Content-Editor’s Project List has only two items: Public 
Outreach and New Customer Tours. This demonstrates the Java WIS 
infrastructure’s ability to customize content for individual users.

9. Click Logout.

➤ To Observe Single Sign-on (SSO)

1. The URL for the EZ offering #0 Welcome page is the following:

http://<machine name>/ezo/welcome.html

If the Welcome page is not already open in your web browser, open it now.

2. In the Welcome page, click Access the Adventure Sports Cafe.

The Adventure Sports Cafe home page opens.

3. Using the fields in the upper right corner of the page, log into the Adventure 
Sports Cafe. Type the following values:

User Name: mary

Password: ascsample

Click Log In. Do not log out.

4. In a new web browser window, open the Welcome page.
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5. In the Welcome page, click Manage Your Access Manager.

The Access Manager user maintenance page for Mary Manager is displayed. 
Mary maintains her basic user data on this page. Mary can even change her 
own password on this page.

Notice that you were not prompted to log in to Access Manager. The Fastplay 
deployment is configured for single sign-on between the Adventure Sports 
Cafe and Access Manager. When you logged in to Adventure Sports Cafe as 
Mary Manager, information about your session was stored in a web browser 
cookie. When you clicked Manage Your Access Manager, the information in 
the cookie authenticated you to Access Manager (which is just another web 
application).

6. You can use the View menu to display additional information about Mary.

7. In the Access Manager window, click Logout.

8. In the Adventure Sports Cafe window, click Logout.

Experiencing Java WIS as a System 
Administrator
The procedures in this section demonstrate how a system administrator uses 
Access Manager to manage user accounts and control access to the content 
delivered by the Java WIS infrastructure.

➤ To Create a New User

This procedure describes how a system administrator creates a new user account.

Before beginning this procedure, verify the proxy settings on your web browser. 
The setting for the local domain should be “no proxy.”

You should also use your web browser’s settings to delete all cookies.

1. The URL for the EZ offering #0 Fastplay Welcome page is the following:

http://<machine name>/ezo/welcome.html

If the Welcome page is not already open in your web browser, open it now.

2. In the Welcome page, click Manage Your Access Manager.

The Access Manager log in page is displayed.
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3. Log in as the Access Manager administrator. Type the following values:

username: amadmin

password: the Java ES password you supplied during the deployment phase

Click Log In. Access Manager displays a page that lists the currently defined 
organizations. In the left pane, notice that the View menu is set to 
Organizations.

4. In the left pane, below the View menu, locate the list of organizations. Click 
adventuresportscafe.com.

The page is refreshed. Notice that the left pane’s heading now indicates that 
the page is displaying information for adventuresportscafe.com.

5. In the View menu, select Users.

The page is refreshed; it displays a list of the users already defined for 
adventuresportscafe.com.

6. Click the New button.

The page is refreshed; the right pane displays fields for defining a new user.

7. In the right pane, locate the list of Available Services. 

These Access Manager services control access to the Adventure Sports Cafe 
portal. These services were configured during the Fastplay deployment 
process.

8. Select all three services by checking the corresponding boxes.

Click Next. The page is refreshed; the right pane displays Required User 
Attribute fields for defining a new user.

9. Type in values for the user you want to create.

Click the Finish button. 

10. In the upper right hand corner, click Save.

11. Click Logout.

➤ To Verify the New User.

1. The URL for the EZ offering #0 Fastplay Welcome page is the following:

http://<machine name>/ezo/welcome.html

If the Welcome page is not already open in your web browser, open it now.
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2. In the Welcome page, click Access the Adventure Sports Cafe.

The Adventure Sports Cafe home page opens.

3. Using the fields in the upper right corner of the page, log into the Adventure 
Sports Cafe. Type the following values:

User Name: <your_new_username>

Password: <your_new_password>

Click Log In. The Home tab displays content that is available to all users. This 
confirms that you successfully created the new user.

4. Click Log Out.

➤ To Deactivate and Reactivate a User Account

This procedure demonstrates some of the Access Manager features for 
authenticating and authorizing web service users.

1. The URL for the EZ offering #0 Fastplay Welcome page is the following:

http://<machine name>/ezo/welcome.html

If the Welcome page is not already open in your web browser, open it now.

2. In the Welcome page, click Manage Your Access Manager.

The Access Manager log in page is displayed.

3. Log in as the Access Manager administrator. Type the following values:

username: amadmin

password: the Java ES password you supplied during the deployment phase

Click Log In. Access Manager displays a page that lists the currently defined 
organizations. In the left pane, notice that the View menu is set to 
Organizations.

4. In the left pane, below the View menu, locate the list of organizations. Click 
adventuresportscafe.com.

The page is refreshed. Notice that the left pane’s heading now indicates that 
the page is displaying information for adventuresportscafe.com.

5. In the View menu, select Users.

The page is refreshed; it displays a list of the users defined for 
adventuresportscafe.com.
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6. Locate the user you created in the preceding procedure. Click the arrow (>) 
that follows the user’s name. The page is refreshed and the user information is 
displayed in the right pane.

7. In the right pane, locate the User Status menu; open the menu and choose 
Inactive.

8. In the upper right corner, click Save.

9. Click Logout.

10. The URL for the EZ offering #0 Fastplay Welcome page is the following:

http://<machine name>/ezo/welcome.html

If the Welcome page is not already open in your web browser, open it now.

11. In the Welcome page, click Access the Adventure Sports Cafe.

The Adventure Sports Cafe home page opens.

12. Using the fields in the upper right corner of the page, log in to the Adventure 
Sports Cafe. Type the following values:

User Name: <your_new_username>

Password: <your_new_password>

Click Log In.

13. Your log in attempt is rejected and you are re-directed to the Access Manager 
page with the following message:

The user is not active

14. To reactivate your user, repeat Step 1-Step 9, and change the user status from 
Inactive to Active.

15. Click Log out.

For more information on Access Manager see Sun Java System Access Manager 7 
2005Q4 Administration Guide (http://docs.sun.com/app/docs/doc/819-2554), and 
other documents in the Sun Java System Access Manager 7 2005Q4 documentation 
collection (http://docs.sun.com/app/docs/coll/1292.1).
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Experiencing Java WIS as an Application 
Administrator

➤ To Log in to the Application Server

This procedure demonstrates logging in to the Application Server Administration 
Console and using the console to manage your deployed web applications.

1. The URL for the EZ offering #0 Fastplay Welcome page is the following:

http://<machine name>/ezo/welcome.html

If the Welcome page is not already open in your web browser, open it now.

2. In the Welcome page, click Manage Your Application Server.

Accept the certificate given (notice that you are opening an HTTPS 
connection). The Application Server log in page is displayed.

3. Log in as the Application Server administrator. Type the following values:

username: admin

password: the Java ES password you supplied during the deployment phase

Click Log In. The Application Server Administration Console main page is 
displayed.

4. In the left pane, locate the node for Applications. Click the arrow (>) to the left 
of the Applications node.

The node expands and displays a list of application types.

5. In the left pane, click Web Applications.

The right pane displays a table of Deployed Web Applications. These 
applications are the web applications deployed on the Application Server 
instance.

❍ Notice that Access Manager is represented by the amcommon, amconsole, 
ampassword, and amserver applications.

❍ Notice that the Adventure Sports Cafe sample application is represented 
by the portal and portletsamples applications.

❍ Notice the controls for administrative tasks such as starting and stopping 
the server and viewing server log files.

6. To view detailed information about an application, locate the Application 
Names column and click the application’s name.
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7. In the left pane, click Stand-alone Instances.

The right pane displays a list of Application Server instances installed on the 
computer. You should see only one instance, named server.

8. Locate the Name column and click server.

The right pane displays detailed information about the server instance. Notice 
that the General tab is selected.

9. Click the Applications tab. 

The right pane displays a list of applications deployed to the server instance.

10. Click the General tab.

Notice the controls for administrative tasks such as starting and stopping the 
server and viewing server log files.

11. When you have finished exploring the Application Server Admin Console, 
click Logout.

For more information on the Application Server Admin Console see Sun Java 
System Application Server Enterprise Edition 8.1 2005Q2 Administration Guide 
(http://docs.sun.com/app/docs/doc/819-2554), and other documents in the Sun 
Java System Application Server Enterprise Edition 8.1 2005Q2 documentation 
collection (http://docs.sun.com/app/docs/coll/1310.1).
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Chapter   3

The Advanced Offerings

This chapter describes how to use EZOffering to deploy the Advanced offerings. 
This chapter contains the following sections:

• “Gathering the Required Information” on page 35

• “Deploying an EZOffering in Advanced Mode” on page 36

• “Using the Deployed Offering” on page 40

Gathering the Required Information
Before you begin your Java EIS EZOffering Advanced deployment, ensure you 
have the correct number of computers for the offering you have chosen to deploy. 
Table 3-1 lists the number of computers needed for each Advanced offering.

Table 3-1 Computers required for Advanced offerings

Offering Number of computers <min> - <max>

#0 Fast Play Enterprise Sample Portal 1

#1 Origin/Content Servers 1 - n

#2 Server-side Java Applications 1 - n

#3 Web Proxy Services with Web Server 2

#3 Web Proxy Services with Application Server 2

#3 Web Proxy Services with existing server 1

#4 Secure web Infrastructure 2 - 3
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To successfully deploy an Advanced offering, you must collect the information to 
be supplied during the deployment process. You need the following information:

• The hostname, domain name, and IP address of each computer that you are 
using in the deployment.

• An administration password that is used for all the deployed components. 
Your password must have a minimum of 8 characters.

• If you deploying the offering on a remote computer, you need the DISPLAY 
environment variable setting of the computer you are working at.

After you gather this information you are ready to install and deploy your 
Advanced offering.

Deploying an EZOffering in Advanced Mode
To deploy an Advanced offering, you perform the following procedures:

1. Installing the Advanced offering. This procedure installs the Solaris™ 10 
Operating System (OS) and the Java WIS component packages.

2. Deploying the Advanced offering. This procedure configures and starts the 
Java WIS components used in the offering.

EZOffering guides you through the installation and deployment procedures, 
which are described in the following sections.

➤ To Install an EZOffering in Advanced Mode

1. Insert the EZOffering DVD into the computer on which you are deploying the 
offering.

The DVD contains a Solaris 10 OS installation program.

CAUTION The installation procedure installs the Solaris 10 OS on your selected 
disk, and all information on the disk (your current OS and your 
data) will be lost.

NOTE If the offering you chose is to be distributed among multiple 
computers, you must repeat the installation procedure on every 
computer you are using in the deployment.
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2. The installation program opens a menu that allows you to choose a 
deployment mode. This menu contains the following options:

EZO WIS (S10U1+JES4) -> FASTPLAY

EZO WIS (S10U1+JES4) -> ADVANCED screen/keyboard/mouse

EZO WIS (S10U1+JES4) -> ADVANCED remote console (ttya)

EZO WIS (S10U1+JES4) -> ADVANCED remote console (ttyb)

Choose the Advanced option that describes the computer on which you are 
installing Java WIS. For example, if you are installing on a computer with 
monitor and keyboard attached, choose ADVANCED Screen/Keyboard/Mouse. If 
you are installing on a remote, networked computer with a console already 
configured, choose either ADVANCED Remote Console (ttya) or ADVANCED 
Remote Console (ttyb).

3. The installation program opens another menu, which allows you to choose the 
installation mode. Press 2 to choose the default installation mode (Custom 
Jumpstart (default)), or wait for the 30 second timeout.

4. The installation program prompts you for the following information:

❍ Language

❍ Network settings (hostname, domain name, IP address)

❍ Root password

❍ Date and region

Type the information you gathered earlier.

5. The installation program displays a licensing agreement. Read the licensing 
agreement. Type Yes to accept the agreement.

6. The installation program reminds you that it will erase all information on the 
disk and prompts you to confirm that you willing to erase the disk. Type Y to 
erase the disk and begin the extraction process.

NOTE EZOffering detects and displays any 
information that it retrieves from your network 
(from DHCP). You decide whether to use the 
information detected by EZOffering or to 
specify your own network settings.
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The installation program extracts the DVD data to the disk.

7. When the installation program completes the extraction process, the DVD is 
ejected. The computer is automatically rebooted. Remove the DVD from the 
DVD reader and wait for the computer to reboot

8. Repeat Step 1 through Step 7 on every computer used in the deployment.

➤ To Deploy an EZOffering in Advanced Mode:

After you complete the installation procedure on every computer used in the 
deployment, you can deploy the Java WIS components.

The Java WIS EZOffering Advanced deployment mode provides a command line 
script that deploys your offering. You run this script on only one of the computers 
in the deployment topology. This computer controls the entire deployment 
process. This computer is referred to as the orchestration node. Choose your 
orchestration node before you begin the deployment procedure.

The procedure for running the deployment script varies, depending on whether 
you run the script on an orchestration node that has a monitor and keyboard 
attached, or whether you run the script from a remote computer.

If you are running the deployment script from a remote computer, begin the 
deployment procedure at Step 1. If you are running the deployment script on an 
orchestration node with attached keyboard and monitor, begin the deployment 
procedure at Step 5.

NOTE If the computer has more than one disk, the installation program 
prompts you to choose the disk on which your Java WIS EZOffering 
is installed.

TIP Depending upon your DVD reader’s speed, the extraction process 
may take some time (around 30 minutes). Please be patient.

CAUTION If you choose a disk that is not the primary boot disk, you must 
update your system’s BIOS before you reboot.
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1. Remote log in to your orchestration node.

$ rlogin -l root <orchestartion node hostname>

password: <provide password>

2. On the local computer you are working from, run the following command to 
disable access control for Xserver display.

$ xhost +

This makes it possible for you to view the GUI for the deployment script that 
you run on the orchestration node.

3. On your local computer, retrieve the DISPLAY environment variable setting

$ echo $DISPLAY

4. On the remote orchestration node, set the DISPLAY environment variable to 
that of your local desktop.

# export DISPLAY=<local desktop hostname>:0.0

5. On the orchestration node, launch the EZOffering deployment script for Java 
WIS. This is an interactive script that guides you through the deployment 
process.

# /opt/SUNWezo/deploy/WIS/wis-deploy.pl

6. Follow the interactive instructions provided by the script. Choose the offering 
you wish to deploy. Type the following information:

❍ host information

❍ administration password

Once you enter all the information, the script automatically starts the 
deployment.

7. The deployment process opens the graphical Monitoring Tool on your 
desktop. The Monitoring Tool provides a visual display showing the progress 
of the deployment.

TIP Some of the deployment steps may take some 
time (10 to 30 minutes), depending upon the 
specification of the computer. Please be patient.
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8. The EZOffering deployment process also validates that the deployed 
components are up and running. When all the icons go green, the deployment 
has successfully finished.

You are now ready to use the deployed offering.

Using the Deployed Offering
➤ To Review the Deployed Components

After you complete the Advanced deployment procedure, you can view the 
EZOffering Welcome page and review the administrative interfaces for your 
deployed components.

1. The URL for the EZ offering Welcome page is the following:

http:<fully qualified hostname>:<port>/ezo/welcome.html

If the Welcome page is not already open in your web browser, open it now.

2. The EZOffering welcome page provides links to the administrative interfaces 
for the Java WIS components you deployed. To log in to a components, click 
the appropriate link and log in with the administrator user names. The default 
administrator names are as follows:

❍ for Application Server, user name: admin

❍ for Web Server, user name: admin

❍ for Web Server as a proxy, user name: admin

❍ for Access Manager, user name: amadmin

The password for all of these administrator accounts is the password you 
supplied during the deployment process.

3. The Welcome page also provides some interesting links to documentation, 
communities and tools.

➤ To Deploy Web Content

To make use of your Java WIS infrastructure you need to deploy some content. The 
procedure depends on the content server you selected. For more information see 
the following documentation:



Using the Deployed Offering

Chapter 3 The Advanced Offerings 41

• For information on Application Server see Sun Java System Application Server 
Enterprise Edition 8.1 2005Q2 Administration Guide 
(http://docs.sun.com/app/docs/doc/819-2554), and other documents in the 
Sun Java System Application Server Enterprise Edition 8.1 2005Q2 
documentation collection (http://docs.sun.com/app/docs/coll/1310.1).

• For information on Web Server see Sun Java System Web Server 6.1 SP4 
Administrator's Guide (http://docs.sun.com/app/docs/doc/819-0130) and 
other documents in the Sun Java System Web Server 6.1 2005Q4 SP5 
documentation collection (http://docs.sun.com/app/docs/coll/1308.1).

• For information on Web Proxy Server see Sun Java System Web Proxy Server 
4.0.1 2005Q4 Administration Guide 
(http://docs.sun.com/app/docs/doc/819-3650), and other documents in the 
Sun Java System Web Proxy Server 4.0.1 2005Q4 documentation collection 
(http://docs.sun.com/app/docs/coll/1311.1).

• For more information on Access Manager see Sun Java System Access Manager 7 
2005Q4 Administration Guide (http://docs.sun.com/app/docs/doc/819-2554), 
and other documents in the Sun Java System Access Manager 7 2005Q4 
documentation collection (http://docs.sun.com/app/docs/coll/1292.1).
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